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DataPro Quick Start Guide 

Introduction 
The DataPro application provides the user with the ability to download and analyze 
data acquired using the ULTRA-LITE PRO range of Auto Meter® products. 

Please see the Software Installation and Set-up Guide for 
information on how to install and set-up the software! 

Getting Started 

Double-click the DataPro icon on the computer desktop to launch the 
DataPro application. 

PIN Code Authorization 
Locate the PIN code information label which can be found on the front of the 
DataPro Installation CD case. 

Note: This information can also be found on the packing list. 

 

+ 

2. Click the 
New 
button to 
clear all 
fields. 

3. If your computer is currently connected to 
the module via the CAN-USB network interface 
and the module is powered on, click the Get 
Tag button.  

4. If your computer is not 
connected to the 
module you can enter 
the module’s Tag 
number manually. 

5. Enter the PIN code exactly as it appears on the 
case label. 

6. Click the Authorize button. If the 
information has been entered correctly, 
the message PIN code authorized 
successfully is displayed. 

1. Select the Authorization option under 
the File menu or press this key sequence. 
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Downloading Data 
The first download task is to set the location on your computer where downloaded 
data should be stored. This information only needs to change when you are racing 
at a different track or you want the runs to be stored in a different session. 

Setting the Track and Session Folders 

 
All downloaded data is stored in a folder structure similar to that shown above. The 
path of the default Data Folder is C:\DataPro but, if required,  you may  change this 
using the Select Data Folder option on the File menu. 

 

There are two download options on the Recorder 
menu. The Download Erase Memory option is the 
most useful as, after a download,  it clears the 
memory ready for the next run. Press the F5 key on 
your keyboard to display the Recorder Download - 
Erase Memory dialog. 

Session Folders may contain one or more runs. The 
Track and Session Folders are created and set 
using the Download Manager. Track and Session 
Folders may be created, using Download Manager, 
prior to download if you so wish. 

1. The Change button is a shortcut to 
the Download Manager where the 
Track and Session Folders may be set. 
Click this button now to display the 
Download Manager. 

Note that the Session field is 
always blank until the 
download has started. 
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Status window 

Data Folder: the root folder of all 
downloaded data.  

Track Folder: a different folder 
for each track at which you 
race.  

Session Folder: a different folder 
for each session at a track.  
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Please make sure the CAN-USB network interface is connecting 
your module to the computer and that the vehicle ignition is on to 
supply power to the module! 

Downloading the Data 

Click the Start button in the Recorder Download dialog to start the download 
process. The Recorder Download dialog updates you with the progress of the 
download in its status window.  
 
If you have the Show Log Book on Data Download option set in Global Properties, 
then the Log Book will be displayed after each run is downloaded so that you may 
enter the Time Sheet values. 
 
If you have the Auto Reset 0 option set in Global Properties, then DataPro will 
automatically calculate the start of pass and set it as time equals zero. If you have 
entered Time Sheet values, the Strip Chart ET markers for 60ft, 330ft, 660ft, 1000ft and 
1320ft are also automatically calculated. If the Auto Reset 0 fails to find the start of 
pass you can use Manual Reset 0 option on the Run Data menu. 
 
When the download is complete, DataPro will load the last downloaded run into 
the current layout for analysis. 

6 

2. Click the New button to 
create a new Track Folder or 
choose a track from the 
dropdown list. 

Track and Session Folders can 
be any alpha-numeric name 
up to 8 characters in length. 
An underscore character may 
also be used in the name. 

4. Double-click the Session Folder cell to change 
the Session. Session Folder names are usually in the 
form: YYMMDDXX to indicate year, month, day 
and driver’s initials. You may also click the 
dropdown arrow button in the Session Folder cell 
and select the <New…> option in the list. This will 
enter today’s date in the cell for you. 

3. If the vehicle list in the 
Download Manager is empty, 
register your module now by 
clicking the Add Vehicle 
button. 

5. Click the OK button to save 
your changes to the Track and 
Session Folders. 
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Important! If you see a dialog similar to this one, 
then you have not yet authorized a PIN code for 
this module. Please see the section on PIN code 
Authorization. 
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Analyzing Data 

Graphical User Interface Overview 

Run Selector Toolbar - selects both 
Current and Reference Runs 

Currently selected 
run number 

Layout Selector Toolbar 
- select, save and 
unlock your analysis 
window Layout 

Main Toolbar - 
move to next or 
previous Run, select 
Single or Compare 
mode and Print 
Screen. 

Strip Chart Y-Axis 
Panel - selects y-axis 
and displays current 
cursor value. 

Statusbar – shows current pass 
time and cursor position. Blue 
text is for the Current Run and 
red text is the Reference Run. 

Zoom Level – 
shows, Run, Pass or 
Selection. 

Strip Chart X-Axis 
Panel – right-click to 
set Time or Distance 
mode and show/hide 
markers. 

Log Book Pane – 
shows Time Sheet 
and all your run 
notes. 
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Layout Panes 

 

1

1 Strip Chart 

2

2 Channel 

3

3 Log Book 

4

4 Rainbow Map 

5 

5 XY Graph 

6 

7 

8 

6 Histogram 

7 Navigational 

8 Picture – insert your Logo! 
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Selecting a Single Run 

 

Click the Single Run button on the Main Toolbar. 

Click the Browse button alongside the 
Current Run on the Run Selector Toolbar 
to launch the Run Selector dialog. 

This view lists all Tracks and 
Sessions within the Data 
Folder. 

This view lists all the Runs in the highlighted 
Session. Double-click a Run to load it into 
DataPro. 

Log Book displays data 
for the highlighted run. 

Pass time for the highlighted 
run is shown here. 

Locate a run easily by 
applying a filter to the lists. 

1 
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Comparing Runs 

 

Then use the Run Selector to select the Reference Run in the same way as the 
Current Run is selected. 

Filtering Runs in the Run Selector Dialog 
The Run Selector’s filter feature allows you to set up to five conditions that are then 
used to filter the Track, Session and Runs listed within the Run Selector dialog. This 
feature allows you to easily locate and load the run of data you are interested in. 

Click the Filter button in the Run Selector dialog to launch the Filter Runs 
dialog. 
 

 

Click to select from a list of all 
the Log Book parameters. 

Click to select from 
a list of conditions. 

Click to set the values 
for the condition. 

This button allows you to load and 
save filters for repeated use.  

Click the Filter button to apply 
the filter to the Run Selector lists. 

1 

Click the Compare Run button on the Main Toolbar. 

Click the Browse button alongside the 
Reference Run on the Run Selector Toolbar 
to launch the Run Selector dialog. 
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Loading a Layout 
Layout is the name given to a collection of data presentation windows (Panes). A 
number of popular Layouts are already available on your computer as part of the 
software installation. 

 

Customizing a Layout 

 

When you unlock the Layout, the window Pane’s border, delete button and gripper 
bar are shown. 

Click the padlock icon to unlock the 
currently loaded Layout for editing. 

Click the dropdown arrow to 
show list of available Layouts. 

Shows preview 
of highlighted 
Layout. 

Shows a short 
description of 
highlighted 
Layout (when 
available). 

Double-click 
item to load 
Layout. 
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Pane gripper bar. To move Pane, 
click and drag to any of the Layout 
window edges. 

Delete Pane button. 

Right-click anywhere on the Pane’s 
border to change the Pane type. 

To add a Pane to the current Layout, choose the Add 
Pane option from the Layouts menu. This will launch the 
Add Pane dialog. 

Simply select the Pane 
type from the dropdown 
list, choose the location 
of the Pane within the 
Layout and click the 
Add Pane button. 

Changing the Main Pane
The Main Pane is usually the largest window in the Layout and will not have a gripper bar 
or delete button like the other Panes.  Choose the Change Main Pane option from the 
Layouts menu.  

Select the Main Pane type 
from the dropdown list in the 
dialog and then click OK. 

When you are done 
adding Panes, close the 
dialog using the delete 
button on the title bar. 

Adding a Pane 
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Click the padlock icon to lock the 
Layout from further changes. 

Click the disk icon to save the 
changes to the Layout. 

If you just want to customize a default Layout, then 
don’t change the name. Otherwise, to create a 
new Layout, enter a new name. 

Enter a category for your new Layout if you want it 
to be categorized under a particular heading in 
the Layout Selector. 

Enter a description for your new Layout. 

Saving your Changed Layout 

Organizing your Layouts 

DataPro’s Layout Organizer allows 
you to customize the Layout 
Selector. Choose Organize Layouts 
from the Layouts menu to launch 
the organizer. 

Uncheck the box next to a Layout 
to prevent it from being shown in 
the Layout Selector. 

Right-click on a Layout name to 
access the context menu where 
you can change the Layout name 
or add a category. 

To change the description of the 
highlighted Layout, edit the text in 
the Comment box. 
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Strip Charts 

Customizing Strip Charts 

 

Left-click a channel 
name to display that 
data channel’s y-axis. 

Right-click a channel 
name or value box to 
display the Strip 

Click and drag the 
splitter bar to 
increase or 
decrease the 
height of the strip. 

Right-click in this area of the y-axis to 
display the context menu shown below. 

Insert Strip will insert a new strip 
chart above the current strip. 

Append Strip will insert a new 
strip chart at the bottom of the 
current strips. 

Properties will show the Strip 
Properties dialog. 

The context menu then lists 
available channels in the 
current run of data. A tick 
against the channel name 
shows that the data channel is 
being displayed on this strip. 
Click a channel name to add a 
channel to or remove a 
channel from the strip. 

The Strip Properties dialog allows 
you to customize several aspects 
of the strip chart. 

Use the Axis Settings tab to set the 
y-axis limits for each channel 
displayed on the strip and change 
background or gridline colors. 

Use the Channel Selection tab to 
add or remove channels to and 
from the strip. 

Use the Line Styles tab to change 
the way the data channel lines are 
displayed. 
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Zooming Data on a Strip Chart 
There are 3 types of zoom mode:  RUN, PASS and SELECTION.  

PASS mode - by default, when a run is loaded, the Layout is in PASS mode. PASS 
mode shows only the data 1 second before the start of pass and 10 seconds after 
(see Global Properties for changing the before and after times). In this mode, right-
clicking on the chart will put the zoom into RUN mode. 

RUN mode - where all the data in the run is displayed. Right-clicking again on the 
actual pass data whilst in RUN mode will bring the zoom back to PASS mode. 

SELECTION mode – infinite zoom into any area of the data. 

 

Customizing Histograms 

 

Right-click anywhere 
within the Histogram 
Pane to display the 
Histogram Properties 
dialog. 

Here you can select 
the displayed 
channel and 
customize the 
histogram. 

For SELECTION zoom 
mode, left-click the 
start of the area of 
interest on the strip, 
while holding down 
the left mouse button, 
drag the cursor to the 
end of the area of 
interest on the strip. 

This highlights the area 
of interest. Right-click 
on the highlighted 
area to zoom in. Right-
click again to zoom 
back out. 

Difference Values 

When the chart is highlighted like this, the cursor 
value boxes show the difference in y-axis values 
between the start and end of the highlighted area. 

When you zoom into data so that 
there are less than 20 data points 
plotted on the graph, the data 
points will be marked with an x. 
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Customizing XY Graphs 

 

Rainbow Maps 

Creating a Map 
Before you can start using Rainbow Maps you must first create a map from your 
data. 

 

Right-click anywhere within 
the Map or Rainbow Map 
Pane to display the context 
menu. Then select the 
Change Map option from 
the menu to launch the 
Create/Select Map dialog. 

1. Use the Browse button to 
select a Run of data. The data 
must have both the LONG_G 
and LAT_G channels present. 

2. Click the Create button to 
create the map. 

3. Select the created PASS 
and then click the Select 
button. 

4. Finally, click the Close 
button. 

Rainbow Maps are a PIN 
coded feature. 

Right-click anywhere within the XY Graph Pane to display the XY Graph Properties 
dialog. 
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Customizing a Rainbow Map 

 

Zooming on a Rainbow Map 

 

Channel Values 
The Channel Values Pane shows the data values for the current position of the 
cursor on the Strip Charts. 

 

Left-click and drag on a 
Map or a Strip Chart to 
select an area of data to 
zoom.  

Right-click within the 
selected area on the Map 
to display the context 
menu. Then select Zoom 
In or Zoom Out. 

Select the 
data channel 
for the 
Rainbow 
Map. 

Select the color 
mode. 
AutoScale is the 
easiest mode 
to configure as 
this 
automatically 
assigns an even 
spread of 
colors for the 
currently 
selected data. 

The Discrete 
mode allows 
you to create 
color bands for 
fixed data 
value ranges. 

Right-click anywhere within the 
Rainbow Map Pane to display 
the context menu. Then select 
the Properties option from the 
menu to launch the Rainbow 
Map Properties dialog. 
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The Difference column is populated when you select an area of data either on a 
Strip Chart or a Map. When you select an area of data, the statistics values are 
based on the selected area only.  

 

Log Book 
The Log Book is a powerful relational database designed to hold all those important 
parameters you need to record for each race. The Log Book is fully customizable as 
to the data it stores and offers a powerful search that can help you identify data 
trends or find specific runs.  

Your first task is to customize the Log Book to your specific requirements. 
Configuration is made easy with the Log Book Configuration dialog. 

Configuring the Log Book 

 

Select the Configure 
Log Book option 
under the Tools menu. 

Max/Min Cursor Jump 

A left-click on the Minimum or 
Maximum value in this Pane will 
move the cursor to that point in the 
Strip Chart and/or Map. 

Right-click the 
Channel Values list 
to display the 
context menu. Use 
the Channel 
Selection option in 
the menu to select 
the channels 
displayed in this list. 

When in Compare mode, both the Current and Reference values 
are shown in the list. Data channels not present in either of the 
Runs are shown as dashed lines. 

Current Run data value  Reference Run data value  

Data channel not 
present in Reference Run.  
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Entering Data into the Log Book 

 

Select the Log Book option under 
the Run Data menu to launch the 
Log Book editor or press this key 
sequence. 

+ 

Note: the Log Book Pane within a Layout is 
read-only. To edit or enter data you must 
use the menu option described here. 

Tabs show all Parameter 
Categories within the Log Book. 

Selecting or clearing these checkboxes will 
show or hide parameters within the Log 
Book. 

Clearing all parameters in a Category will 
hide that whole Category within the Log 
Book. 

Add a new 
Category by 
entering a new 
Category name 
and an initial 
Parameter. 

Add a new Parameter 
by entering a new 
Parameter name to an 
existing Category. 

Check or uncheck the appropriate 
boxes to permanently delete the 
Parameters or Category. 

DataPro can be configured to automatically launch the Log Book editor after a data 
download. Please see the section on Global Properties for instructions on how to enable 
this feature. 
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Log Book Searching 

 

+ 
Select the Search Log Books option 
under the Tools menu or press this key 
sequence. 

Column headings 
include all Log 
Book Parameters. 

The Search Log Books dialog 
displays a separate row for 
each Run that contains a Log 
Book entry. 

Click the column 
header buttons to 
sort the entries. 

Right-click the 
table to display 
the context menu 
shown here. 

Fast Run Selection 

Use the Filter menu option to find the Run you want and 
then choose the Select As Current Run or Select As 
Reference Run menu option to load the highlighted Run. 

Currently selected Run. 

Tabs show 
Parameter 
Categories 
including 
the two 
built-in 
categories: 
Time Sheet 
and Run 
Info. 

Import button used to 
copy Parameters from 
a previous Run. 

The blue edge indicates that 
the displayed Log Book 
belongs to the Current Run. In 
Compare mode, the 
Reference Run Log Book has 
a red edge. 
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Global Properties 

 

Select the Global Properties option 
under the Run Data menu or press this 
key sequence. 

+ 

The Channel Settings tab allows you to set 
displayed channel units and the number 
of decimal places for numeric values. The 
channel colors are also set here. You may 
also apply a filter to a data channel.  

The Channel Groups tab allows you to 
set-up groups for similar channels so that 
those channels within a group have a 
single setting for Units, Decimals and Strip 
Chart Y-axis Limits.  

To create a group simply click the New 
Group button and enter a unique name 
for the group. Then drag one or more 
channels from the Channels list into the 
group you have just created. 

If Auto Reset 0 is checked, then DataPro 
will automatically calculate the start of 
the pass from the recorded longitudinal 
G-meter data. If DataPro is not able to 
find the start of pass, try changing the 
Launch G Threshold. 

You can also set the before and after 
times for PASS mode zoom. Set these 
values to zero if you want to switch this 
feature off. 
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Math Channels 

Executing a Math Channel Calculation 

Creating a New Math Channel Calculation 

 

        Click the New button to 
create a new math channel 
calculation.  

This will launch the Math 
Channel Wizard.  

Creating new Math 
Channel calculations 
is a PIN coded feature. 

Answer the 
questions in the 
wizard to start a 
new Math 
Channel 
calculation.  

This will launch 
the Math 
Channel Wizard.  

1 

+ Select the Math Channels option 
under the Run Data menu or press this 
key sequence. 

To calculate a math 
channel, first select 
the required 
calculation from the 
list and then click the 
Execute button.   

Batch calculations generate more than 
one math channel and are marked with 
this icon.   

Default calculations 
are marked with red 
icons and may not 
be edited or deleted. 

Shows the formula of the 
currently highlighted 
calculation.   

If a calculation 
requires extra 
parameter values, 
you may enter them 
here. 

1
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Alarms 
Alarms allow you to pinpoint various events in the run data. 

Executing an Alarm 

 

Select the Alarms option 
under the Run Data menu. 

Creating new 
Alarms is a PIN 
coded feature. 

To calculate an 
Alarm, first 
select the 
required Alarm 
from the list and 
then click the 
Execute button.   

A

This speed bar opens the 
various Formula Component 
folders for you.  

Enter the mathematical 
formula here.  

Double-click any 
item in the Formula 
Components list to 
insert it into the 
Formula box above.  

These read-only boxes provide help 
text for the currently highlighted 
Formula Component item.  

Enter a description 
of your Math 
Channel here.  

Double-click the Units cell to 
change the units of any of the data 
channels used in the calculation. 
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Creating a New Alarm 

Viewing an Alarm Report 

 

         Click the View Report button on the Alarms 
dialog to display the Session Alarm Report dialog.  
A 

Alarm bell icon 
indicates 
alarms exist 
within a session. 

Double-click on 
alarm event to 
highlight the 
area in a Strip 
Chart 

Filter Alarm statistics. 

Print 
Alarm 
reports. 

Click the New button to 
create a new Alarm. This 
will launch the Alarm 
Editor. 

1. Select a channel from 
the list of channels 
available in the 
currently selected run. 

2. Select the condition. 3. Enter the 
threshold value. 

4. Enter any delay you 
want on the test. 

5. Enter a 
description of the 
Alarm. 

You can also use the Gate checkbox 
and dropdown list to select another 
Alarm to gate with this one. 

6. Click the OK 
button when you 
have finished 
setting the Alarm 
properties. 
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Importing Data 

Importing Racepak® Data 

 

Importing Auto Meter® Data Facts Pro Data 

 

Select the Import Data submenu from the 
File menu and then choose the Data Facts 
Pro option. 

The import procedure is 
the same as that 
described above. 

The Channel Name Translation dialog gives you a chance 
to assign DataPro channel names to the Racepak® 
channels. In this way, when the run is loaded, the Layout 
can automatically display the imported channels without 
you having to add them.  

Double-click the DataPro Name cell to get a list of standard 
channel names or type a new name in the cell. 

If you do not supply a DataPro Name, a compatible one 
will be created for you by DataPro based on the original 
Racepak® channel name but you will have to add this 
channel to Panes manually. 

Note that this translation information is stored for further use. 

When you click the OK button the Run is imported and 
loaded into DataPro along with any stored Time Sheet 
values. 

Select the Import Data submenu from the 
File menu and then choose the 
Racepak® option. 

Click the Browse button and 
locate the Racepak® rpk data 
file you want to import. 

Enter or select the 
Track, Session and Run 
number where you 
would like the 
imported Run saved. 

Click the Import 
button when 
ready. 
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Notes 
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AUTO METER PRODUCTS, INC 
413 West Elm Street 
Sycamore 
IL 60178 
 
Technical Support (Toll Free) 
866.248.6357 
Technical Support 815.899.0801 
Fax 815.895.6786 
 
http://www.autometer.com 

2650-1401-00 


